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Introductie Masterclass 
 
Welkom bij de masterclass Game Design. In deze masterclass geven we een 
introductie over game design. 
 
Bij het ontwerpen en creëren van games komt veel kijken: level design, character 
modeling, programmeren, visual arts, geluid en noem maar op. In deze masterclass 
zullen we beginnen met basic level design en met name textures en objecten maken. 
 
Zoals je misschien al weet gaan we werken met het spel Half-Life 2. Dit is een first-
person-shooter gebouwd op de geavanceerde Source Engine. Deze engine staat 
bekend om zijn geweldige ingebouwde physics. Mede hierdoor hebben we voor Half-
Life 2 gekozen. Bovendien is het ook mogelijk om je eigen Mod(ification)s te maken. 
Het bekende Counter-Strike is een voorbeeld van zo een Mod. Een ander voorbeeld is 
VU-Life 2, een Mod met elementen uit de VU. Deze Mod gaan we gebruiken voor 
demonstraties. 
 
In deze masterclass geven we je een overzicht van de geschiedenis van spellen, 
vertellen we je over wat er komt kijken bij het maken van een spel en mag je zelf aan 
de gang met de volgende dingen: 
 

• Experimenteren met het toevoegen van textures aan objecten. 
• Het uiterlijk veranderen van een model van Half-Life 2. 
• Basis objecten maken in een level.  

 
Veel succes! 
 
Het VUgame team 
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Les 1: de geschiedenis 
v a n co m p u t er sp el l en en 
het  m a k en v a n sp el l en 
 

De geschiedenis van spellen 
 
Welkom bij de geschiedenis van computerspellen. Wist je dat computerspellen 
meerdere malen gezorgd hebben voor een kleingeld tekort in Japan? Of dat het eerste 
computerspel al meer dan 40 jaar geleden is gemaakt? Deze en andere leuke of 
interessante weetjes vind je hier. 
 
Er was eens... Of nou ja, eigenlijk was het niet zo duidelijk wat nou het eerste spel 
was. In 1951 krijgt Ralph Baer de opdracht om "het beste tv-toestel ter wereld" te 
bouwen. Zijn suggestie is om een soort interactief spel toe te voegen aan dit tv-toestel. 
Maar zijn idee wordt genegeerd. Pas in 1967 wordt zijn idee werkelijkheid als Bear 
mee helpt met het bouwen van de Magnavox Odyssey. In de tussentijd heeft in 1958 
William Higinbotham het spel Tennis for Two gemaakt, als leuk onderdeel van een 
open dag van het laboratorium waar hij werkt. In 1961 maakt Steve Russel ook een 
spel: Spacewars!. Zowel Higinbotham als Russel hebben beiden niet het idee iets 
bijzonders gemaakt te hebben en vragen dan ook geen patent aan. Ralph Bear doet dit 
wel en officieel heeft hij dus het eerste spel gemaakt. De meningen verschillen over of 
hij nou werkelijk de eerste was, maar in ieder geval was hij de eerste die met het idee 
kwam. 
 
Gelijk met de ontwikkeling van spellen komt de markt voor spelautomaten op. 
Hiervan verschijnt in 1971 de eerste, gemaakt door Nolan Bushnell. Dit was geen 
succes. Bushnell is nog steeds overtuigd van zijn plan en daarom richt hij Atari op. De 
tweede automaat is het spel PONG, gemaakt door Atari en dit is wel een grote hit. In 
eerste instantie zijn het vooral spelautomaten waarop nieuwe spellen verschijnen 
omdat goede thuissystemen nog niet echt haalbaar zijn. Klassiekers als Space 
Invaders, Asteroids, Pac-Man, Donkey Kong, Pole Position en Street Fighter II 
kwamen voor het eerst op de spelautomaten uit en werden zeer fanatiek gespeeld in 
hun tijd. De spellen die op de spelautomaten uitkwamen zijn vaak later geconverteerd 
naar thuissystemen, sommigen wat minder goed dan anderen. 
 
Begin jaren 80 komt de laser Disc op. De Laser Disc biedt de mogelijkheid om veel 
meer data op te slaan en hierdoor is een interactief verhaal als Dragon's Lair mogelijk. 
Het zat deze nieuwe technologie helaas niet mee. 
 
Tot aan 1983 gaat alles erg goed met de computer spellen markt. Er zijn vele 
verschillende thuiscomputers op de markt, spelautomaten zijn razend populair, er lijkt 
geen eind aan te kunnen komen. Helaas blijkt dit toch te kunnen. In 1984 zijn er te 
veel producten op de markt en stort de hele boel in elkaar. Veel kleinere bedrijven 
gaan failliet en ook de grotere hebben het moeilijk door grote hoeveelheden niet 
verkochte producten. 
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In 1985 begint de industrie weer langzamerhand op te krabbelen na dus flink onderuit 
te zijn gegaan. Voornamelijk Tetris is populair in deze tijd. In 1985 begint Nintendo 
ook te testen met zijn nieuwe systeem, het Nintendo Entertainment System (NES). 
 
De NES is een groot succes en in 1986 wordt hij op de markt gebracht met als 
introductie spel Super Mario Bros.. Voor Nintendo volgden er nog vele hits op hun 
NES, zoals The Legend of Zelda en Final Fantasy. Naast het grote succes van de NES 
is ook de Game Boy een grote hit. De mogelijkheid om spellen overal waar je maar 
wil te kunnen spelen spreekt iedereen aan. Veel van de spellen voor de NES komen 
ook in aangepaste vorm uit op de Game Boy. Een grote hit speciaal voor de Game 
Boy is de Pokémon reeks. 
 
SEGA, Nintendo's grootste concurrent zit niet stil tijdens dit alles. Ze besluiten hun 
eigen mascotte te lanceren om te concurreren met Mario. Dit wordt Sonic the 
Hedgehog. Helaas krijgt SEGA het niet voor elkaar om te blijven concurreren met 
Nintendo. In 2001 gooit SEGA de handdoek in de ring en stopt met het produceren 
van spelcomputers. Wel gaat het door met het produceren van software en 
spelautomaten en zo kan het gebeuren dat je nu Sonic aan kunt treffen op Nintendo 
systemen. 
 
De ontwikkelaars van computers hebben ondertussen ook niet stil gezeten en voor dit 
systeem is veel gebeurt sinds Spacewars!. In het begin waren de spellen simpel en 
veelal text-based. Spellen als King's Quest en Leisure Suit Larry zijn hiervan erg 
bekend. Ook waren er veel spellen gebaseerd op populaire spelautomaten en waren 
spellen waarin je een sport beoefend zoals Summer Games in het begin erg populair, 
al komen deze nu meer voor op de spelcomputers. In 1989 kwam er een uniek en 
nieuw spel uit voor de pc, namelijk SimCity. Simulatoren zijn sindsdien een populair 
genre op de pc; zo kan je zelfs een hele familie besturen in The Sims. De pc wordt 
gezien als meer volwassen dan de spelcomputers en hier komen dan ook meer 
volwassen spellen voor uit, zoals Doom, Tomb Raider en Carmageddon. 
 
Hoewel de pc altijd zich toch het meest op volwassenen gemikt heeft zie je ook bij de 
spelcomputers verschillen tussen de leeftijden waar meestal op gemikt wordt. De 
Playstation en Xbox mikken traditioneel meer op oudere spelers, terwijl de 
GameCube juist meer gaat voor de jongere. Dit wil natuurlijk niet zeggen dat er op 
deze spelcomputers echt alleen spellen uitkomen voor deze leeftijdsgroepen. 
 
De laatste tijd zijn er echt weinig nieuwe en innovatieve spellen te vinden. 
Fabrikanten zijn nu vooral bezig alles mooier te maken, allemaal nieuwe snufjes toe te 
voegen en de gameplay te verbeteren. Natuurlijk zijn dit goede ontwikkelingen, maar 
echt iets totaal nieuws komt er op deze manier niet. Veel van de spellen die nu uit 
komen zijn niet duidelijk anders dan oudere spellen, alleen maar veel mooier en vaak 
ook online te spelen. Online spelen zelf is waarschijnlijk een van de belangrijkste 
ontwikkelingen van de laatste tijd en veel spellen en alle spelcomputers voor thuis die 
nu uitkomen ondersteunen het. Het is te verwachten dat fabrikanten op hetzelfde pad 
door zullen gaan en om de zoveel tijd zullen nieuwe, innovatieve spellen uitkomen. 
 
Het is lastig om nu in te schatten wat echt de belangrijkste spellen van onze tijd zullen 
zijn, vandaar dat dit overzicht slechts tot 2000 loopt. Hiernaast is het onmogelijk om 
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een volledig overzicht van alle spellen te maken die ook maar een beetje populair zijn 
geweest, vooral ook omdat sommige spellen alleen binnen bepaalde groepen populair 
waren. Om deze redenen biedt dit overzicht slechts een kleine greep uit alle spellen 
die hier vermeld hadden kunnen worden. Dit zijn wel allemaal spellen die behoren tot 
de belangrijksten in hun tijd en genres. 
 

Voor 1970 
 
De Tweede Wereldoorlog geeft een enorme impuls aan het maken van computers. 
Geheime codes die de verschillende partijen moeten ontcijferen kosten namelijk veel 
rekenwerk en rekenen is iets waar computers uitermate goed in zijn. Sindsdien 
ontwikkelt de computer zich steeds verder. De eerste computers hadden bijna een 
klein huis nodig aan ruimte, maar langzamerhand worden de computers kleiner en 
wordt de rekenkracht groter. 
 
De eerste bug (nu bekend als een fout in een programma of computer) die ooit 
veroorzaakt werd in 1945, was veroorzaakt door een echte "bug": een mot vloog naar 
binnen bij een van de eerste computers en kwam vast te zitten in het systeem. De 
computer liep hierdoor vast, maar nadat de mot er uit was gehaald werkte hij weer. 
Hier komt de term "debugging" dan ook vandaan. Een ander interessant feit is dat er 
in 1955 244 computers in de Verenigde Staten waren, samen hadden deze computers 
minder rekenkracht dan een kleine computer in 1980. 
 
Met de grote ontwikkelingen op computer gebied zijn opeens veel meer dingen 
mogelijk. In 1958 wordt het eerste spel gemaakt, maar dit werkt nog volledig 
hardwarematig. In 1961 is het eerste spel op een computer een feit. 
 
Tussen 1960 en 1970 worden veel ontwikkelingen gedaan. In 1962 krijgen de 
Amerikanen het voor elkaar om met hulp van alle nieuwe ontwikkelingen op 
computergebied hun eerste astronaut de ruimte in te krijgen en in 1969 land de eerste 
man op de maan. Verder is in 1968 de eerste spelcomputer voor thuis werkelijkheid. 
Ook is de eerste spelautomaat in ontwikkeling, hoewel deze pas later in de 
automatenhallen te vinden zal zijn. 
 
Belangrijke data: 
 

• 1889 oprichting Nintendo. 
• 1891 oprichting Philips. 
• 1947 oprichting Sony. 
• 1951 de eerste commerciële computer komt op de markt, dit is de UNIVAC I. 
• 1951 Ralph Baer komt met het idee om een spel in te bouwen in een televisie. 
• 1954 oprichting SEGA. 
• 1958 William Higinbotham maakt Tennis for Two. 
• 1961 Steve Russel maakt Spacewar!. 
• 1968 een patent wordt aangevraagd op Baer's interactieve televisie.  
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1970 - 1980 
 
De trend in computers om alles steeds kleiner en sneller te maken zet zich door. 
Gordon Moore ziet dit en doet in 1973 de voorspelling dat elke 1.5 jaar het aantal 
transistors op een computer chip zal verdubbelen. Ruim 20 jaar later gaat zijn 
voorspelling nog steeds op. Eind jaren '70 beginnen de thuiscomputers op te komen. 
 
In 1970 wordt een volledig geautomatiseerde supermarkt opgezet. De vraag is zo 
groot dat de supermarkt het niet bij kan benen en uiteindelijk gaat de supermarkt 
hieraan ten onder. Wanneer in 1976 een computerspel gebaseerd op de film Deathrace 
2000 uitkomt, is dit het eerste spel dat om morele redenen verboden wordt. Het was in 
dit spel de bedoeling om punten te halen door mensen omver te rijden. Jaren later zal 
het spel Carmageddon dat hetzelfde principe bevat ook nog voor veel discussie 
zorgen. Bij eerdere computer spellen wordt vaak niet vermeld wie het spel gemaakt 
heeft. Sommige programmeurs zijn het hier niet mee eens en beginnen stiekem hun 
naam te verstoppen in hun spellen. 
 
Steve Jobs en Steve Wozniak die later Apple op zullen richten werkten eerst voor 
Atari. Voor Atari maakten zij het spel Breakout, wat uiteindelijk het beste spel van 
1976 wordt. Hoewel Jobs zo ongeveer $5.000 ontvangt hiervoor, vertelt hij Wozniak 
dat het slechts $700 was. Wanneer Jobs en Wozniak hun eerste reeks computers 
maken doen ze dit voor een groot deel met van Atari "geleende" onderdelen. Atari 
zelf is ook in deze tijd opgericht, net als Microsoft. Microsoft is nog steeds een van de 
belangrijkste spelers op de markt, Apple doet ook nog leuk mee. Van Atari wordt 
weinig meer vernomen. 
 
Belangrijke data: 
 

• 1970 het eerste portable computerspelletje (Game & Watch) wordt door 
Nintendo uitgebracht. 

• 1971 de eerste computergestuurde speelautomaat verschijnt in de 
automatenhallen. 

• 1972 de eerste e-mail wordt verzonden. 
• 1972 de cd wordt uitgevonden. 
• 1972 oprichting Atari. 
• 1975 geldautomaten worden geïntroduceerd. 
• 1975 oprichting Microsoft. 
• 1975 de eerste draagbare computer is een feit, dit is een voorloper van de 

laptop. 
• 1976 oprichting Apple.  

 

1980 - 1990 
 
Het wordt steeds betaalbaarder voor mensen om zelf een computer te hebben. In 1980 
zijn wereldwijd ongeveer 724.000 thuiscomputers in gebruik. Begin jaren '80 is de 
VCS van Atari (die al in 1977 uit kwam) de belangrijkste spelcomputer. Halverwege 
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de jaren '80 krijgt Nintendo een groot deel van die markt in handen met de NES 
terwijl het langzaam aan slechter met Atari begint te gaan. 
 
Voor 1984 lijkt echt alles te kunnen, maar dan blijkt dit toch niet helemaal waar te 
zijn. Een begin van de problemen is te zien als Commodore $100 korting geeft op een 
systeem van hen bij het inleveren van een ander systeem. Competitie die systemen 
aanbiedt voor onder de $100 worden zo heel handig uit de markt gedrukt. Dit werkt 
omdat deze systemen tegen minder dan de kostprijs aangeboden worden, met het idee 
winst te maken op de Commodore software. Ook veel grotere bedrijven komen in de 
problemen. Zo wordt onder andere het personeelsbestand Atari halverwege de jaren 
'80 teruggebracht naar minder dan 7% van wat het was op het toppunt van het bedrijf. 
Dit werd gedaan in een poging om de kosten naar beneden te krijgen. Dit was 
succesvol en Atari kon het nog een aantal jaar langer vol houden. 
 
Computers worden ondertussen op steeds meer gebieden toegepast. Michael Jackson 
laat met zijn Victory tour in 1984 zien dat computers enorm kunnen helpen voor een 
mooie show. Bij zijn optreden worden 6 computers gebruikt voor de bediening van 
licht, geluid en een robot spin. Tot deze tijd werden computers niet op deze schaal 
gebruikt bij optredens. Ook James Bond haakt in op het hele computer fenomeen. In 
de film “A View To A Kill” moet James Bond een nieuwe computerchip terug vinden 
die de Russen gestolen hebben. In Frankrijk automatiseert de politie zijn systeem om 
aanklachten rond te sturen. In 1989 gaat hier iets mee mis en krijgen 41.000 inwoners 
van Parijs aanklachten voor moord, afzetting of prostitutie op de mat in plaats van 
verkeersboetes. Het gebruiken van computers gaat dus niet altijd goed. 
 
Belangrijke data: 
 

• 1980 een computer verslaat voor het eerst een schaakgrootmeester; hierbij 
moet vermeld worden dat de grootmeester tegen 26 mensen tegelijk aan het 
spelen was waarbij 3 mensen instructies kregen van computers. 

• 1981 Xerox komt als eerste met het idee van de computermuis. 
• 1981 de eerste vrouwelijke computerspellen designer levert haar eerste spel af. 
• 1982 er valt voor het eerst een dode bij het spelen van een computerspel. 
• 1983 afgesproken wordt dat TCP/IP het standaard protocol voor Internet 

wordt. 
• 1983 Windows wordt aangekondigd. 
• 1985 de eerste versie van Windows komt daadwerkelijk uit. 
• 1986 Nintendo komt met de NES, een revolutionaire thuiscomputer gebaseerd 

op het Famicom systeem dat in 1984 al in Japan uitkwam.  
 

1990 - 2000 
 
In dit decennium zien we de opkomst van een nieuwe generatie spelcomputers en het 
Internet. De nieuwe spelcomputers zijn sneller, genereren mooiere beelden en hebben 
veel extra's. Vaak hebben deze nieuwe spelcomputers ook de mogelijkheid om het 
Internet op te gaan. Op deze manier kun je tegen mensen over de hele wereld spelen. 
Helaas heeft het Internet niet alleen voordelen; zo kunnen computervirussen zich 
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makkelijk verspreiden via het Internet en zorgen dan ook voor veel schade in deze 
jaren. 
 
Tegen het eind van het decennium begint een probleem te ontstaan. Oude 
computerprogramma's slaan data op met 2 cijfers voor het jaar, om ruimte te 
besparen. Bij de eeuwwisseling verandert (19)99 dus in (20)00. Er wordt gevreesd dat 
veel oude programma's 00 niet zullen interpreteren als 2000, maar als 1900, waardoor 
heel veel dingen mis zouden kunnen gaan. In de laatste jaren van deze eeuw wordt 
veel tijd en geld besteed aan het oplossen van deze zogenaamde millennium bug en 
uiteindelijk valt de schade erg mee. 
 
Op de Olympische Zomerspelen van 1996 zou IBM de computers regelen om het 
geheel te ondersteunen. IBM heeft een aantal beloftes gemaakt en zou belangrijke 
klanten van alles laten zien. Uiteindelijk zijn er veel problemen, moeten een hoop 
dingen met de hand gedaan worden en zijn de systemen vaak down. Zelfs met 3 jaar 
voorbereiding blijkt een groot bedrijf als IBM zoiets groots als de Olympische Spelen 
niet goed te kunnen regelen. 
 
De computer Deep Blue wint het eerste potje van een beste van de 6 schaakwedstrijd 
tussen de computer en Garry Kasparav. Het tweede potje is voor Kasparav, waarop 2 
potjes volgen waar geen winnaar uit komt. Het 5e potje wint Kasparav weer en ook 
het laatste beslissende potje wint hij. Mens wint nog steeds van de machine. Een paar 
jaar later zal Deep Blue wel winnen. 
 
In 1998 wordt een chat georganiseerd met Koko, een 26 jaar oude vrouwelijke gorilla. 
Deelnemers stellen vragen die vertaald worden naar gebarentaal. Koko's antwoorden 
worden terug vertaald en terug gestuurd naar de chatters. 
 
Belangrijke data: 
 

• 1991 de SNES wordt uit gebracht. 
• 1993 prototypes van de eerste PDA's worden getoond. 
• 1994 de eerste harde schijf met 1 gigabyte aan ruimte komt uit. 
• 1994 de eerste computers die sneller gaan dan 100 MHz komen op de markt. 
• 1994 de Playstation wordt uit gebracht. 
• 1995 Windows '95 komt uit. 
• 1995 de Sony Playstation is te koop. 
• 1995 E-Bay start. 
• 1996 Atari wordt opgeheven. 
• 1996 De Nintendo 64 komt uit na al in 1993 aangekondigd te zijn. 
• 1998 SEGA brengt de Dreamcast op de markt.  

 

2000 en later 
 
De ontwikkelingen bij de spelcomputers gaan door. Sony komt met de Playstation 2, 
Nintendo met de GameCube en ook Microsoft stort zich op de markt met de Xbox. De 
nieuwe spelcomputers doen niet onder voor thuiscomputers van slechts enkele jaren 
eerder. Ingebouwd in de spelcomputers zitten harde schijven en modems om via het 
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Internet te kunnen spelen. Er kan verwacht worden dat de markt voor spelcomputers 
nog lang zal blijven bestaan, waarbij waarschijnlijk uiteindelijk de spelcomputers 
steeds meer weg gaan hebben van gewone computers. 
 
Naast de spelcomputers voor thuis vinden er ook ontwikkelingen plaats op het gebied 
van spelcomputers die je zelf mee kunt nemen voor onderweg. Nintendo heeft niet stil 
gezeten met de ontwikkeling van zijn Game Boy, met ondertussen kleurenversies en 
extra processorkracht die er voor zorgen dat het spelen van SNES spelen al 
gemakkelijk haalbaar is. Op dit gebied komt er ook een nieuwe ontwikkeling op, 
mensen krijgen namelijk steeds geavanceerdere mobiele telefoons. Waren een paar 
jaar geleden zwart-wit schermen en heel simpele spelletjes de norm, ondertussen 
hebben mobieltjes kleurenschermen van een behoorlijke grootte, ingebouwde 
camera's en processors die dit alles aan kunnen. De spelletjes die nu op mobiele 
telefoons gespeeld kunnen worden doen al niet zo heel veel meer onder voor die op de 
Game Boy. 
 
Voor de mensen met een gewone computer met Internetverbinding zijn er vele gratis 
spelletjes online te vinden. Vaak zijn deze spelletjes ook tegen anderen te spelen. Ook 
komen er steeds meer spellen bij die massaal te spelen zijn via het Internet. Voor 
sommige van deze spellen log je in op een wereld met duizenden mensen tegelijk, 
waarbij de wereld gewoon door draait als jij er weer af gaat. Het is waarschijnlijk dat 
het Internet alleen maar meer mogelijkheden gaat bieden voor het spelen van spellen. 
 
Omdat het steeds makkelijker wordt om thuis spelletjes te doen, neemt de populariteit 
van de spelautomaat de laatste jaren gestaag af. Veel belangrijke producenten van 
spelautomaten stoppen dan ook met het produceren van deze automaten. 
Waarschijnlijk liggen de mogelijkheden voor de spelautomaten vooral bij het 
integreren met spelcomputers, waardoor spellen zowel voor de automaten als voor de 
spelcomputers gemaakt kunnen worden. 
 

Links 
 
The Dot Eaters: Classic Video Game History (Engelstalig) 
(http://www.thedoteaters.com/) - The Dot Eaters is een zeer uitgebreide site die vooral 
focust op de begintijd van de computerspellen, ongeveer tot halverwege de jaren 80. 
Veel van de weetjes over de eerdere spellen komen van deze site. 
 
GameSpot presents: The History of Video Games (Engelstalig) 
(http://www.gamespot.com/gamespot/features/video/hov) - Gamespot biedt een 
overzicht van de vele belangrijke gebeurtenissen in de geschiedenis van videospellen. 
Ook wordt veel informatie weergegeven over de situatie om de games zelf heen. De 
informatie op deze site loopt ongeveer tot 2001. 
 
Wikipedia (meerdere talen) (http://www.wikipedia.org/) - Wikipedia is een van de 
meest uitgebreide encyclopedieën op het Internet. Wanneer je informatie zoekt over 
een specifiek spel, is dit een van de beste plekken om te kijken. Doordat iedereen bij 
kan dragen aan deze encyclopedie is de informatie die je vindt niet altijd even goed, 
maar zolang je hier rekening mee houdt hoeft dit geen probleem te zijn. 
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ICWhen (Engelstalig) (http://www.icwhen.com/) - ICWhen biedt een uitgebreid 
overzicht van de ontwikkelingen van computerhardware in de loop van de tijd. Ook 
vind je er veel over software, zoals wanneer bepaalde spellen uitkwamen en door wie 
ze uitgegeven werden. 
 

Het maken van een spel 
 
Er is één ding dat aan de basis staat van elk spel: het idee. Zonder een goed idee ben 
je nergens. Je spel staat of valt met het idee. Dit idee moet genoeg zijn om andere 
mensen enthousiast te maken voor jouw spel. Wat je dus wilt doen is dit idee goed 
uitleggen in een beschrijving van wat het idee achter het spel is, waarom mensen dit 
zo leuk zouden moeten gaan vinden en wat de doelgroep is. 
 
Met je beschrijving ga je naar een bedrijf toe dat spellen maakt, of, als het even kan 
werk je daar al en ga je gewoon naar je baas toe. Je missie is nu om anderen warm te 
maken voor jouw spel. Een bedrijf als dit krijgt met enige regelmaat nieuwe ideeën 
binnen en je moet zorgen dat de jouwe uitspringt tussen de rest. Als alles goed gaat 
overtuig je aan de hand van je beschrijving en je eigen uitleg de mensen van het 
bedrijf. Deze zorgen nu dat er geld beschikbaar komt om mee verder te werken. 
 
Je eerste taak is nu om het spel verder te ontwerpen. Hoe werken dingen precies, wat 
zijn de regels van het spel, wanneer win je het spel, etc. Probeer hierbij genoeg andere 
mensen je ontwerp te laten lezen en gebruik vooral hun commentaar voor 
verbeteringen. De kans is klein dat jij de enige bent met goede ideeën. Wanneer je 
denkt dat er geen verbetering meer mogelijk is maak je je uiteindelijke ontwerp. Dit 
ontwerp leg je voor aan je bazen en wanneer deze ook hiervan onder de indruk zijn 
kun je verder gaan. 
 
Je gaat nu specifieker uitleggen hoe de dingen die je verzonnen hebt geïmplementeerd 
moeten worden. Denk hierbij bijvoorbeeld aan wat voor muziek nodig is, wat voor 
animaties, wat voor algoritmes je nodig hebt (stukjes programmeercode die iets 
specifieks doen) en wat voor budget je nodig hebt. 
 
Een ander belangrijk onderdeel dat nu gemaakt moet worden is de "graphic bible". Dit 
document bevat een beschrijving en uitwerking van hoe onderdelen van het spel er uit 
moeten zien. Denk bijvoorbeeld aan tekeningen van je hoofdpersoon of van 
belangrijke locaties binnen je spel. Aan de hand van de "graphic bible" zullen de 
verschillende zichtbare objecten en/of personages in je spel gemaakt worden. 
 
Het laatste onderdeel dat je wil hebben voor je daadwerkelijk begint met het spel 
maken is een gedetailleerde beschrijving van het verloop van het spel: dit is een soort 
uitleg van hoe je van het begin van het spel naar het eind gaat komen en welke 
stappen je daartussen allemaal nemen kan. Het lastige hieraan is dat veel spellen niet 
lineair zijn en je dus allemaal verschillende manieren hebt om van het begin naar het 
eind te komen. 
 
Er vanuit gegaan dat je zo ver gekomen bent en het bedrijf waar je voor aan het werk 
bent nog steeds vertrouwen heeft in je project, is het nu tijd om daadwerkelijk het spel 
te gaan maken. Een van de eerste dingen om te doen is uitzoeken of het nuttig is om al 
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bestaande pakketten om spellen te bouwen te gebruiken voor bepaalde onderdelen van 
het spel, of dat je alles helemaal zelf nieuw bouwt. Hoeveel tijd zelf bouwen kost is 
hierbij vooral erg relevant, maar ook de kosten tellen natuurlijk hard mee. Voor het 
demonstratiespel dat we getoond hebben bij deze masterclass is bijvoorbeeld de editor 
van Half-Life 2 gebruikt. Deze editor laat je je eigen levels in elkaar zetten, laat je 
objecten bouwen en regelt dingen als licht en geluid voor je. Zelf dit alles bouwen 
was zeker geen optie aangezien het project dan vele malen langer had geduurd. De 
laatste tijd komen er veel spellen uit die je dit soort mogelijkheden geven, al zijn ze 
niet allemaal zo uitgebreid als die van Half-Life 2. 
 
Als je besloten hebt hoe alles gemaakt gaat worden dan is het voor je programmeurs 
tijd om te gaan programmeren en kan je grafisch ontwerper aan de gang met het 
maken van plaatjes en modellen voor in je spel. Zelf leid je het project in goede banen 
en werk je mee aan de onderdelen waar je kunt. 
 
Na een tijd van hard werken ben je klaar en kan het spel uitgebracht worden. Het is 
hierbij zaak om het onder de aandacht te krijgen en dan te hopen dat mensen het leuk 
vinden en het kopen. Jouw taak zit erop en hopelijk heb je een hit te pakken! 
 
Op de VU kun je vakken volgen zoals Visual Design, Multimedia Design Casus, 
Human Computer Interaction en meer. Deze vakken leren je verschillende belangrijke 
vaardigheden die aan de basis staan voor het ontwerpen van interactieve programma's 
zoals spellen. Visual Design leert je (nadenken over) visueel ontwerpen. Bij de 
Multimedia Design Casus leer je een 3D wereld bouwen en bij Human Computer 
Interaction leer je over interface design, zeg maar het ontwerpen van het deel wat de 
gebruiker ziet. 
 
(Natuurlijk is dit een versimpelde weergave van alles wat hierbij komt kijken.) 
 

Huiswerk voor les 2 
 
Volgende les is het de bedoeling dat je zelf aan de gang gaat met het toevoegen van 
plaatjes in een 3D omgeving. Om dit te doen moet je natuurlijk wel wat plaatjes mee 
hebben. Probeer of je plaatjes van de volgende dingen kunt vinden: 
 

• Plaatjes van een materiaal, bijvoorbeeld hout of metaal. 
• Plaatjes van posters. 
• Plaatjes van een bekende omgeving, bijvoorbeeld je kamer.  

 
Deze plaatjes moeten in het jpg formaat zijn en moeten een van de volgende 3 
afmetingen hebben: 128 x 128 pixels, 256 x 256 pixels of 512 x 512 pixels. 
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Les 2: zelf aan de gang 
m et  een H alf-Li fe 2 m ap  
 

Voorbereiding 
 
Op de computers waar de deelnemers de masterclass gaan volgen staat het volgende 
vooraf geïnstalleerd: 
 

• Half-Life 2 en Steam (In D:\Program Files\Valve). 
• VU-Life 2 Mod (In D:\Program Files\Valve\Steam\SteamApps\SourceMods). 
• VTFEdit (In D:\VTFEdit). 
• Masterclass conversie programma (In D:\Masterclass Converter). 
• Een grafisch tekenprogramma.  

 
Bovendien hebben alle deelnemers alvast mee (optioneel): 
 

• Plaatjes van materiaal (hout, metaal, etc) in .jpg formaat. 
• Plaatjes van posters in .jpg formaat. 
• Foto's van een bekende omgeving/kamer.  

 
Eventueel kunnen de deelnemers tijdens de masterclass zelf nog naar plaatjes zoeken 
op het Internet. 
 

I nt rodu c t ie t ex t u res  
 
Om met textures te kunnen beginnen, moet je eerst weten waar alles zit en wat je 
allemaal precies moet aanpassen. Allereerst de directory structuur. 
 
Het spel is geïnstalleerd in D:\Program Files\Valve. Ga hier naar toe met Windows 
verkenner (of via My Computer). Vervolgens blader je verder totdat je zit in 
D:\Program Files\Valve\Steam\Steamapps\SourceMods. In deze directory zitten alle 
Mods die je zelf hebt gemaakt (of gaat maken in de toekomst). 
 
Als het goed is staat hier een map Vu-Life 2. In deze map zit 1 directory die 
belangrijk is voor vandaag, namelijk materials. Hier zit namelijk alle textures in die 
worden gebruikt in deze Mod. Wij zullen alleen de mappen masterclass en ninja 
gebruiken hiervan. 
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Hier moet je zijn! 
 

Textures converteren 
 
Half-Life 2 en de Mods hiervan gebruiken een speciaal formaat om de textures op te 
slaan. Voor elke texture zijn er 2 bestanden nodig: het .vtf bestand en het .vmt 
bestand. Het eerstgenoemde is de texture zelf en het laatstgenoemde is een 
tekstbestandje waarin onder andere staat beschreven wat het voor texture is en waar 
het zich bevindt. 
 
Het is mogelijk om een willekeurig .jpg plaatje om te zetten naar het vtf bestand. Er is 
echter 1 voorwaarde: de plaatjes moeten 128 pixels x 128 pixels, 256 pixels x 256 
pixels of 512 pixel x 512 pixels zijn. Houd hier rekening mee voordat je begint met 
converteren. 
 
Er zijn twee manieren om je .jpg om te zetten naar vtf en vmt (het is handig om ze 
beide eens uit te proberen): 
 

• Conversie met masterclass programma 
In de directory D:\Masterclass converter staat een programma die 
MasterClass.exe heet. Het gebruik van het programma is vanzelfsprekend en 
ziet er als volgt uit: 
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Met "…" kan je een jpg plaatje selecteren. Vervolgens moet er een naam 
ingetikt worden (je krijgt later een lijstje met namen die je kan gebruiken) en 
daarna op "convert" gedrukt worden. De texture wordt nu automatisch 
gegenereerd en gekopieerd naar de goede map in de Vu-Life 2 Mod. Denk 
eraan dat je plaatje van de juiste grootte moet zijn, anders weigert het 
programma de conversie. 

 
Samenvatting: 
o Zorg dat je plaatje van het juiste formaat is (128x128, 256x256 of 512 x 

512). 
o Start MasterClass.exe in D:\MasterClass converter. 
o Selecteer jpg file. 
o Vul een naam in. 
o Druk op "convert".  

 
• Conversie met VTFEdit 

Werkt het bovenstaande programma niet, of is het niet aanwezig? Dan moet de 
texture conversie gedaan worden met VTFEdit, die zich bevindt in 
D:\VTFEdit. Bij het dubbelklikken van VTFEdit.exe wordt het volgende 
programma opgestart: 
 

 
 
Je kan je eigen jpg file laden door op File -> Import te klikken. Nadat je het 
plaatje hebt geselecteerd krijg je een optie scherm. Klik hier gewoon op OK. 
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Het .vtf bestand kan dan gegenereerd worden door naar File -> Save te gaan. 
Het andere bestand (.vmt) kan je genereren door te gaan naar Tools -> Create 
VMT file. Onder het tabblad "options" kan je bij "Surface 1" ook nog 
aangeven hoe de texture zich moet gedragen (bijvoorbeeld als metaal). Druk 
op create en selecteer de locatie en naam. 
 

 
Alles wat deze texture heeft zal zich gedragen als metaal. 
 
Samenvatting: 

o Zorg dat je plaatje van het juiste formaat is (128x128, 256x256 of 
512x512). 

o Start VTFEdit.exe uit map D:\VTFEdit. 
o File -> Import en selecteer je jpg file. 
o Druk op OK bij option scherm. 
o File -> Save As om .vtf te genereren. 
o Tools -> Create VMT file om .vmt te genereren. 
o Geef onder Surface 1 in tabblad options het gedrag van de texture aan. 
o Druk op create.  

 

Textures toevoegen 
 
We weten nu hoe wij textures kunnen converteren. Nu gaan we echt beginnen met 
aanpassen. Eerst gaan we kijken hoe de level er nu uitziet. 
 
Opstarten van het spel: 
 
 

• Dubbelklik op het Steam icoontje rechtsonder in de taakbalk. Je krijgt nu 3 
tabbladen te zien: Store, Games en Tools. 

• Onder Games staat Vu-Life 2. Dubbelklik hierop om het op te starten. 
• Het spel start en als alles gereed is, staat er een menuoptie "Masterclass". Klik 

hierop om de level te bekijken die we gaan aanpassen.  
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Het vervangen van textures 
 
Het is nu mogelijk om veel objecten aan te passen met je eigen texture. Hier volgt een 
tabel met welke texture bij welk onderdeel van de kamer hoort: 
 
Welk object Texture naam 
Vloer van deze kamer mc_vloer 
Muur van deze kamer mc_binnenmuur 
De tafels mc_tafels 
De boekenkasten mc_boekenkasten 
Poster 1 mc_poster1 
Poster 2 mc_poster2 
Poster 3 mc_poster3 
Poster 4 mc_poster4 
Poster 5 mc_poster5 
Poster 6 mc_poster6 
Plafond van deze kamer mc_plafond 
Stoep buiten mc_buiten_stoep 
Muurschilderij buiten, linkerkant mc_wall_left 
Muurschilderij buiten, midden mc_wall_midden 
Muurschilderij buiten, rechterkant mc_wall_right 
 
Links van deze tabel staat een beschrijving van het object dat je wil aanpassen; rechts 
staat de naam van de texture die je moet vervangen om je object aan te passen. 



 24

 
Een voorbeeld: Je wilt de texture van de vloer van de kamer vervangen door je eigen: 
 

• Zoek in de tabel de juiste naam. Hier: mc_vloer. 
• Start een van de twee texture programma's. 

o Als je mc_vloer als naam invult bij het masterclass conversie 
programma, dan wordt de texture (.vtf en .vmt) automatisch naar de 
juiste locatie gekopieerd. 

o Bij VTFEdit moet je de .vtf en .vmt bestanden beide opslaan in de map 
Vu-Life 2\materials\masterclass. Zie paragraaf over directory structuur 
als je niet meer weet waar alles staat.  

• Als je de texture hebt vervangen, start het spel op en bekijk het resultaat!  
 
Nog een aantal opmerkingen: 
 

• Bij sommige textures is het van belang / mooier als ze goed overlopen (bij 
textures die overlopen zie je geen "grens" als je ze achter/onder elkaar zet). Dit 
geldt bijvoorbeeld voor de vloer en muren. Het is een goede oefening om een 
texture die niet goed overloopt, zo aan te passen dat het wel goed overloopt. 

• Het muurschilderij buiten de kamer (de muur waar je het meeste zonneschijn 
ziet), bestaat uit 3 delen. Oefening: zorg dat je met deze 3 delen 1 enkel groot 
plaatje kan laten zien. 

• Verder mag je de textures van de level aanpassen zoals je zelf wilt. Zodra je 
denkt dat je dit allemaal onder de knie hebt, ga dan verder met het aanpassen 
van een model.  

 

Het uiterlijk van een model aanpassen 
 
Zoals je misschien al gezien hebt, staat er een ninja in de kamer. Het uiterlijk van deze 
ninja kan, net als alle andere objecten, aangepast worden. Alleen gaat het bij een 
model iets anders. 
 
In de Vu-Life 2 map zit een NinjaSkin-map. Hierin zit een voorgemaakte .jpg van het 
uiterlijk (de skin) van de ninja. Open deze in je favoriete graphics programma en je 
zult zien dat het een andere opbouw heeft dan de andere textures. Het is aan jou om de 
juiste indeling te vinden. Waar moet je wat aanpassen? Waar zitten de mond, ogen, 
handen, schoenen, etc? Probeer verschillende dingen aan te passen op verschillende 
plekken om hier achter te komen. 
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Hmm… waar is zijn mond nou gebleven? 
 
Om je nieuw gemaakte skin te testen, doe je het volgende: 
 

• Dit keer kan je het masterclass conversie programma niet gebruiken (vanwege 
een andere locatie van de ninja skin). 

• Open VTFEdit en importeer de ninja-skin. 
• Sla deze vervolgens op in de directory Vu-Life 2\materials\ninja als 

bestandsnaam nskingr.vtf. 
• Maak geen .vmt bestand aan! Het .vmt bestand dat al aanwezig is, hoeft niet 

vervangen te worden. 
• Start nu het spel en bekijk je ninja.  

 
Als je er eenmaal achter bent gekomen waar je de lichaamsdelen kan aanpassen, dan 
kun je verder gaan met het toevoegen van objecten aan de map in de officiële editor: 
Hammer. 
 

De Hammer editor 
 
Sommige spellen geven je de mogelijkheid om zelf levels en maps te maken, je eigen 
spelomgeving zeg maar. Half-Life 2 is hier een van. Bij Half-Life 2 kan dit met de 
Hammer editor. Deze editor geeft je toegang tot alle objecten die in het spel 
voorkomen, maar ook geeft hij je de mogelijkheid om zelf nieuwe objecten aan te 
maken. Een editor als deze is natuurlijk een stuk makkelijker dan met de hand alles 
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helemaal zelf te moeten coderen; vandaar dat de makers van een spel graag een editor 
gebruiken. 
 
Voor onze les is het nuttig dat Hammer ons kan helpen met het maken en bewerken 
van objecten in 3D. We zullen dan ook uitleggen hoe dit werkt en je zelf ook wat 
laten maken hiermee, maar eerst moet je natuurlijk weten hoe je Hammer op kunt 
starten en weten waar je de belangrijkste functies kunt vinden. 

Hoe start je de Hammer editor? 
 
Opstarten Hammer: 
 

• Dubbelklik op het Steam icoontje rechtsonder in de taakbalk. Je krijgt nu 3 
tabbladen te zien: Store, Games en Tools: . 

• Onder Tools staat Source SDK. Dubbelklik hierop om het te starten. Na wat 
geduld te hebben gehad krijg je het Source SDK scherm. 

• Bovenaan het Source SDK scherm zie je Applications staan met daar meteen 
onder Hammer Editor. Controleer nog even of helemaal onderaan bij Current 
Game wel VU-Life 2 staat; selecteer deze anders. Dubbelklik op Hammer 
Editor om de editor te starten. Na nog wat geduld te hebben gehad kom je in 
de editor. 

 

Waar vind je de basisfuncties en hoe werken deze? 
 
Voordat we beginnen met uitleggen waar alles zit, eerst maar even een screenshot van 
hoe alles er uit ziet na het opstarten: 
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Als we nu gaan beginnen met het maken van onze eigen map dan zouden we nu naar 
File gaan en New doen. Omdat wij al een basis map hebben gemaakt voor jou om uit 
te breiden doen we dat niet. In plaats van op New te drukken druk je op Open... Het is 
nu de bedoeling dat je onze map gaat openen. Deze vind je door naar D:\Program 
Files\Valve\Steam\Steamapps\SourceMods\VU-Life 2\maps\ te gaan en dan te 
dubbelklikken op masterclass.vmf. Je ziet nu als alles goed is gegaan dit: 
 

 
 
Omdat je camera standpunt in het vak linksboven nog niet echt ideaal is gaan we daar 
eerst eens naar kijken. Met A, S, D en W kun je naar voren, naar achteren, naar links 
en naar rechts bewegen. Met de pijltjes toetsen kun je rond je as bewegen. Wanneer je 
shift ingedrukt houdt en de pijltjes toetsen gebruikt kun je naar link, naar rechts, naar 
boven of naar beneden. De muis heeft dezelfde functionaliteit als de pijltjes toetsen 
nadat je Z ingedrukt hebt. 
 
Dit is waarschijnlijk wat veel tegelijk, dus laten we het nu gewoon eens gaan 
uitproberen. Kijk eens of je met deze knoppen de camera naar het midden van de 
ruimte kunt bewegen. 
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In het vak rechtsboven zie je de ruimte van bovenaf, terwijl je in de vakken links- en 
rechtsonder de voorkant en zijkant ziet. Met hulp van deze views kun je je ruimte en 
alle objecten die er in staan bekijken. Het is helaas niet mogelijk om de andere zijkant 
of de achterkant te zien. 
 
Als je linksboven in een vak met de rechtermuisknop op zijn naam klikt kun je 
eventueel wijzigen wat er in het vak getoond wordt. Ook kun je voor de 3D view 
("camera") instellen hoe objecten getoond moeten worden. De standaard instellingen 
zijn bijna altijd de goede, het kan alleen nodig zijn om de 3D view op 3D textured te 
zetten als hij dat nog niet staat. 
 
Het maken en bewerken van objecten wordt verderop uitgelegd. Hiermee kun je 
dingen wijzigen en toevoegen in onze map. Als je hiermee klaar bent wil je natuurlijk 
wel eens zien hoe jouw map er uit ziet. 
 
Ga naar file en kies voor Save. Als je dit gedaan hebt ga je weer naar File, nu kies je 
voor Run Map... er komt nu een schermpje te voorschijn waar je dingen in kunt 
stellen voor het draaien van de map. Dit laat je mooi voor wat het is en druk meteen 
op ok. Je moet nu een tijdje geduld hebben totdat je map geladen is in Half-Life 2. 
Houd er rekening mee dat dit al snel enkele minuten kan duren. En nu spelen maar! 
 

Objecten maken 
 
In de Hammer editor is het mogelijk om 3D objecten aan te maken. Dit doe je door 
standaard objecten uit Hammer met elkaar te combineren tot je het gewenste resultaat 
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hebt. Als eerst selecteer je aan de linker kant van het scherm de Block Creation Tool. 
Het met rood omlijnd icoontje is de Block Creation Tool: 
 

 
 
Je kunt er eventueel ook voor kiezen om de Shift+B shortcut te gebruiken. 
 
Als je dit gedaan hebt moet je kiezen wat voor object je wil maken. Je doet dit door 
aan de rechterkant van het scherm onder Objects te kiezen wat voor object je maken 
wilt. Je ziet hier een plaatje van waar je het kan selecteren. 
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Dit zijn de verschillende vormen die je kunt maken: eerst een plaatje met kleur op de 
buitenkant van de objecten en daaronder een plaatje met alleen lijnen zodat je voor 
sommige van de vormen beter kunt zien wat wat is. 
 

 

 
Van link naar rechts zie je hier: arch, block, cylinder, sphere, spike, torus en wedge. 
 
Nu je weet wat wat is kun je gaan proberen om een object te maken. In elk vak, 
behalve die van de camera kun je je object tekenen. Dit doe je door de linker muisnop 
ingedrukt te houden en te slepen. Op het plaatje hieronder zie je dit. 
 

 
 
Als je object de juiste afmetingen heeft druk je er met je rechtermuisknop op. Je kunt 
nu Create Object doen en nu wordt je object gemaakt. Voor sommige objecten komt 
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er nu een scherm omhoog waarin je verschillende dingen in kunt stellen, 
experimenteer hier gerust mee. het object maken zie je hieronder: 
 

 
 
Bij het tekenen van je object stel je 2 van zijn 3 dimensies in. De derde dimensie 
wordt automatisch ingesteld, maar meestal is dit niet op de waarde die jij wilt hebben. 
Kies nu een van je views waarin je de 3e dimensie goed kunt zien en pas je object 
aan. Dit aanpassen doe je door een van de blokjes aan de rand te pakken en te gaan 
slepen. 
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Ondertussen kun je je gemaakte object ook terug vinden in de camera view. Je 
uiteindelijke resultaat ziet er als volgt uit: 
 

 
 
Je kunt nu je object verder bewerken door bijvoorbeeld de afmetingen nog wat meer 
te veranderen, of door hem te roteren, te vergroten of verkleinen. Dit laatste vind je 
allemaal door met de rechtermuisknop op je object te klikken en transform te 
selecteren. 
 
Het is natuurlijk niet alleen maar mogelijk om deze basisvormen te maken. Wanneer 
je meerdere objecten naast elkaar zet en je ze beiden selecteert kun je de optie group 
op ze gebruiken. Deze vind je door met de rechtermuisknop op je object te klikken en 
group te selecteren. Een group kun je op dezelfde manier bewerken als één object. 
 
Bij het selecteren van meerdere objecten kan het handig zijn om Ctrl in te drukken en 
om dan een voor een op ze te klikken terwijl je de Ctrl ingedrukt houdt. Op deze 
manier kun je heel precies bepalen wat je allemaal wel en niet selecteert. 
 
Voor dit voorbeeld is even niet de standaard map gebruikt om wat makkelijker te 
kunnen laten zien wat er gebeurt, maar het werkt natuurlijk precies hetzelfde als je 
iets toe wilt voegen aan deze map. Mocht je het willen proberen na te doen dan kun je 
altijd een stukje naast de map aan de gang gaan om precies hetzelfde beeld te krijgen 
als in deze voorbeelden. 
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Resources 
 
Game @ VU -- www.cs.vu.nl/~eliens/game 
Documentatie -- www.cs.vu.nl/~eliens/game/masterclass.pdf 
Masterclass -- www.cs.vu.nl/~eliens/multimedia/game.html 
Project pagina -- www.few.vu.nl/~vugame 
Game Development -- www.cs.vu.nl/~eliens/design/game.html 
 


